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Introduction

SmartPower is Actel’s state of the art power analysis tool. Power 
analysis is a convenient and thorough method of analyzing, debugging 
and validating the power performance of a design. This is achieved by 
breaking the design down into a nets, blocks, and gates, and then 
calculating the power requirements of the component parts.

Not all the features described in this manual are available for all 
devices. Minor exceptions for device families are noted in the text. 

Document Organization
This guide provides detailed cross-platform information about 
SmartPower. Use it as a reference in your everyday work.

It provides step-by-step instructions for Windows and Unix platforms. 
Platform differences in procedures and commands are noted in the 
text.

This user’s guide is divided into the following chapters:

Chapter 1 - Getting Started with SmartPower introduces the 
SmartPower graphical user interface and menu commands.

Chapter 2 - Using SmartPower contains instructions on how to use 
SmartPower to perform power analysis.

Appendix A - Product Support provides information about 
contacting Actel for customer and technical support.

Document Assumptions
This document assumes you have a working knowledge of your 
operating system and its conventions, including standard menus and 
commands. It also assumes you know how to use a mouse, and how 
to open, save, and close files. For help with any of these techniques, 
see the documentation that came with your computer.

This document assumes you are familiar with the FPGA architectures 
and design flows, as well as the Designer software.
5



Introduction
Document Conventions
This document uses the following conventions:

All references to ProASIC in this manual apply to both ProASIC and 
ProASICPLUS devices. 

Your Comments
Actel Corporation strives to produce the highest quality online help 
and printed documentation. We want to help you learn about our 
products, so you can get your work done quickly. We welcome your 
feedback about this guide and our online help. Please send your 
comments to documentation@actel.com.

Actel Manuals
Designer and Libero include printed and online manuals. The online 
manuals are in PDF format and available from Libero and Designer’s 
Start Menus and on the CD-ROM. From the Start menu choose:

• Programs > Libero 2.3 > Libero 2.3 Documentation. 

• Programs > Designer Series > R1-2003 Documentation

Also, the online manuals are in PDF format on the CD-ROM in the  
“\manuals” directory. These manuals are also installed onto your system when 
you install the Designer software. To view the online manuals, you must install 
Adobe® Acrobat Reader® from the CD-ROM.

The complete list of Designer Series manuals is available on the Actel websit at 
http://www.actel.com. 

Online Help
The Designer Series software comes with online help. Online help specific to 
each software tool is available in Libero, Designer, ACTgen, ACTmap, Silicon 
Expert, Silicon Explorer II, Silicon Sculptor, and APSW.
6



1
Getting Started with SmartPower

The SmartPower tool supports ProASIC, ProASICPLUS, and Axcelerator 
devices at this time. If you are not using one of these devices, the SmartPower 
icon disappears from the toolbar and the User Tools, the SmartPower 
command does not appear in the Tools menu, and the SmartPower icon does 
not appear in the Designer main window. 

This chapter contains details about SmartPower’s user interface 
and commands. For information on using SmartPower to 
perform power analysis (including examples) please refer to 
“Using SmartPower” on page 27. 

Calculating Power with SmartPower
When you launch SmartPower for the first time, all clocks are assigned a 
frequency of 10 MHz by default. In addition, SmartPower sets all data 
frequencies to 1 MHz. In order for you to accurately measure the power 
consumption of a design, you must specify the target clock and data 
frequencies. For a more detailed explanation of the SmartPower user flow, 
please refer to “Power Analysis with SmartPower” on page 28. 
7



Chapter 1: Getting Started with SmartPower
SmartPower Toolbar
The SmartPower toolbar (Figure 1-1) contains commands for performing 
common SmartPower operations on your designs. Click on a button in the 
toolbar to access a command. 

Figure 1-1. SmartPower Toolbar

SmartPower Menu Commands
The PC and workstation versions of SmartPower have the same menus. 
However, some dialog boxes may look slightly different on the two platforms 
due to the different window environments. The functionality is the same on 
both platforms, though the locations of the fields and buttons on the dialog 
boxes may vary. The names of some fields may also vary between the PC and 
workstation versions.

File Menu Commit: Commits power information to Designer. You must commit your 
changes if you wish to save your settings in SmartPower. If you commit your 
changes, the information is stored in the .adb file, and your settings are restored 
the next time you open your design in SmartPower. 
Export Grid (enabled in Dynamic tab): Exports the selected area of the Report 
Window to a text (.txt) file. 
Print Grid (enabled in Dynamic tab): Prints the selected area of the Report 
Window. 

Export

Copy Power
Report

Print

Commit

Path Grid

Path
Grid

Grid
PathChange

Settings
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Status Bar
Preferences: Invokes Preferences dialog box, where you can set analysis and 
display preferences 
Close: Closes SmartPower 

Edit Menu Add Domain (enabled in the Domains tab): Adds a clock domain or set of 
pins. 
Remove Domain (enabled in the Domains tab): Removes a domain. 
Copy Grid: Copies the selected cells of the dynamic grid onto the clipboard 

Tools Menu Report Power: Generates power report 

Status Bar
SmartPower’s status bar, located at the bottom of the SmartPower window, 
displays information on menu commands. 

Invoking SmartPower
You can only use SmartPower after you open an existing design (post-layout 
*.adb file), or after compiling and layout of your netlist in Designer. If you 
invoke SmartPower before compiling your netlist, Designer guides you through 
the compile and layout. 

There are three ways to invoke SmartPower analysis tool:

1. Choose SmartPower from the Tools menu, or

2. Click the SmartPower icon in Designer’s toolbar, or 
9



Chapter 1: Getting Started with SmartPower
3. Click the SmartPower button in Designer’s design flow (User Tools).

SmartPower opens in a separate window, as shown in Figure 1-2 on page 11. 
The user interface consists of a preference window, a report window and four 
tabs: Summary, Activity, Dynamic and Domains (SmartPower defaults to the 
Summary tab). These four tab screens, the Preference window, and the report 
window are described in the following sections.
10



Invoking SmartPower
Summary Tab The Summary tab is divided into three sections: Power Consumption, Average 
Switching Activities, and Temperatures (Figure 1-2). 

Figure 1-2. SmartPower Summary Tab Screen

• Power Consumption - Displays the total static and dynamic power of the 
design. 

• Average Switching Activities - (includes the average frequency of the 
clock-pins and data-pins of the selected clock domain). For designs with 
multiple clocks, SmartPower selects the first clock domain in alphabetical 
order by default. You may choose another clock domain using the drop-down 
menu. It is also possible to select a set of pins rather than a clock domain. If 
you select a set of pins instead of a clock domain, SmartPower reports only 
one average frequency (the average frequency of all the pins of the selected 
set).

Average Switching Activities are useful when you import a VCD (value 
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Ambient Temp.
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Chapter 1: Getting Started with SmartPower
change-dump) file (PC only) or a SAIF file. Since a VCD file lets you specify 
the frequency of each pin individually, it is often useful to know the average 
clock- and data-pin frequency for a particular clock. Please refer to page 20 
for more information on how to import a VCD or SAIF file. 

You can import a VCD or SAIF file to specify switching activity for a design 
to create an accurate power usage model in SmartPower. 

• Temperatures - Displays the impact of the power consumption on the 
junction temperature for a given cooling scenario and ambient temperature. 
You can specify a cooling scenario using the drop-down menu (available 
scenarios are: still air, 300 feet/min., and case cooling; default is still air). 
SmartPower also reports the thermal resistance, θJA.

Activity Tab The Activity tab is used to attach switching activity information on 
interconnects of the design (Figure 1-3). 

Figure 1-3. Activity Tab

The Activity tab is divided into three sections: 

• Clock Domain - Displays the selected clock domain (or set of pins). Use the 
drop-down menu to select a different clock domain. 
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Invoking SmartPower
• Switching Activities Estimation - Enables you to specify the global clock 
frequency and data frequency for the given clock domain (or set of pins). Use 
this screen to modify the clock-frequency and data-frequency for the selected 
clock-domain. For designs with multiple clocks, SmartPower defaults to the 
first clock in alphabetical order (you can specify different clock-domain using 
the drop-down menu). It is also possible to select a set-of-pins rather than a 
clock-domain. In that case, only 1 frequency can be modified (this frequency 
is used for all the pins of the selected set).

• Switching Activities Annotation - Enables you to specify the switching 
activities for individual pins in the Clock Domain. SmartPower displays the 
pins that have not been annotated in the Not Annotated list box. 

Select a pin and specify a different frequency for this pin using the text-box 
and the Set To button. When you select a pin and specify a frequency, 
SmartPower removes the pin from the Not-Annotated list-box and adds it to 
the Annotated list-box. Hold down the CTRL key and click with the mouse 
to select multiple pins. 

Use the Select All button to select all the pins in a list-box. Filter boxes are 
provided below the list boxes to limit the size of each list of pins. Enter text 
in these boxes and click Set to apply this text as a filter (the * character is a 
wildcard). It is also possible to limit the type of each list of pins using a drop-
down menu that enables you select All-Pins, Data-Pins or Clock-Pins.
13



Chapter 1: Getting Started with SmartPower
Dynamic Tab The Dynamic tab enables you to inspect detailed hierarchical reports of the 
dynamic power consumption. The Dynamic tab consists of two windows: the 
hierarchy of instances window, and the report window. 

Figure 1-4. Dynamic Tab

SmartPower displays the hierarchy of instances in a list in the hierarchy window. 
Sub-blocks of a block are shown in the tree when you click the plus sign (+) 
next to the block. Only hierarchical blocks are displayed in this list (no gates or 
nets). 

When you select a block of the hierarchical tree, SmartPower displays its name 
and its dynamic power consumption in the report window. 

SmartPower displays the list of sub-elements of the selected block in the Report 
window. By default, this list includes all sub-elements. The dynamic power 
consumption of each sub-element is displayed with useful information like the 
fanout and the driver-name for a net, or the macro model-name for a gate. You 
may limit the list of sub-elements to a list of sub-blocks, or gates, or nets, or any 
combination of these 3 classes of sub-elements. You may also sort the list 
according to different criteria (double-click a column label to sort the list based 
on this column, or change the sort-order). 
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Window
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Invoking SmartPower
You can export (to a text file) and print the grid that details your design’s power 
consumption. To do so, select the elements of the grid that you wish to export 
or print, and then from the File menu select Export Grid or Print Grid, 
respectively. 

Domains Tab The Domains tab consists of two windows: the Domain Management window 
and the Pin Management window. You can use these windows to add or 
remove domains. In addition, you can change the clock and/or data frequency 
of a selected domain. 

The Domain Management window displays a list of existing domains with their 
corresponding frequencies. You may also select a set-of-pins rather than a 
clock-domain (Figure 1-5). 

Figure 1-5. Domains Tab

Any pins that do not belong to a Clock domain are listed in the “All Pins not in 
a Domain” list box in the Pin Management window. You can select a pin from 
the “All Pins not yet in a Domain” list box and add it to the current domain. 
You may also select a pin from the current domain and remove it from the 
domain (this pin will appear in the “All Pins not yet in a Domain” list box). Use 
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Pins Not In
A Domain

Delete Selected Domain
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Pins Already in
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Window
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Chapter 1: Getting Started with SmartPower
the CTRL key while selecting with the mouse to select multiple pins. Use the 
Select All button to select all pins displayed in a list. 

You may filter the list of pins using the filter boxes below the list boxes. Enter a 
text in the filter boxes and click Set to apply this text as a filter (the * character 
is a wildcard). 

You may also filter the type of pins listed in the domain using the drop-down 
menu. Choose from All-Pins, Data-Pins or Clock-Pins in the drop-down menu 
to refine your choice. Create a new clock domain and set of pins as needed. 

To create a new clock domain: 

1. Click Add Domain from the Domain Management window. 

2. Select the clock domain. This opens the Create Clock Domain dialog 
box. 

Or, from the Edit menu, select Add Domain, and Add Clock Domain. The 
Create Clock Domain dialog box appears, as shown in Figure 1-6. 

Figure 1-6. Create Clock Domain Dialog Box

In the Create-Clock-Domain dialog box, choose a clock in a list of potential 
clocks. Based on this selection, SmartPower constructs a new clock-domain. 
The lists of clock-pins and data-pins of this new Clock-Domain are 
automatically computed (their computation is based on the netlist topology). 
You may also set a clock-frequency and a data-frequency for this new clock. It 
is possible to create a new clock-domain without selecting a potential-clock. If 
you do so, you must enter a name for this new clock-domain, and the list of 
clock-pins and data-pins is not computed automatically (you must do it 
manually). 

Specify Potential Clock Pin

Specify Clock and 
Data Frequencies
16



SmartPower Preferences Dialog Box
To create a new Set of pins: 

1. Click Add Domain in the Domain Management window. 

2. Select a set of pins. This displays the Create Set of Pins dialog box 
(Figure 1-7). 

Figure 1-7. Create Set of Pins Dialog Box

3. Input the name and frequency for the new set of pins. 

Alternatively, from the Edit menu, select Add Domain and Set of Pins to open 
the Create Set of Pins dialog box. 

You can use the Create Set of Pins dialog box to enter a name for this new 
domain, but the domain created is empty (no pins added to this newly created 
set). You can also set a frequency for this new Set of Pins.

SmartPower Preferences Dialog Box
The Preferences dialog-box enables you to set options that affect the graphical 
and textual reports (Figure 1-8). To open the Power - Preferences dialog box, 
from the File menu choose Preferences. Alternatively, you can click Options in 

Enter

Specify 

Name

Frequency
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Chapter 1: Getting Started with SmartPower
the Power - Report (select Report Power from the Tools menu) dialog box (see 
“SmartPower Reports” on page 19). 

Figure 1-8. SmartPower Preferences Window

The Preferences dialog box is divided into five sections: 
• Maximum List Size Control - Enables you to limit the size of all lists 

displayed in the SmartPower tab screens; options are grayed out and 
unavailable at this time 

• List Sort Control - Modifies the default sort for all the lists in SmartPower 
(available sort keys are Alphabetical or Power values, in either ascending or 
descending order) 

• Units - Sets units preferences for power and frequency

• Operating Conditions - Displays operating conditions; Typical is the only 
option available at this time

• Block Expansion Control - Filters reported power values returned in the 
report. This box does not control which values are included, rather it 
specifies which blocks are detailed/expanded.
You may specify which blocks are expanded using a minimum power value, 
a minimum power ratio (with regards to the total power of the design) and a 
maximum hierarchical depth; a filtered value is not included in displayed lists, 
but still counted for upper hierarchical levels. 
18



SmartPower Reports
SmartPower Reports
SmartPower gives a report of all the activities of the design. There are two ways 
to generate a report: 

• Click the Power Report button in the toolbar. 

• From the Tools menu, select Report Power (Figure 1-9) 

Figure 1-9. Report Dialog Box

You have several options in the Report Dialog Box. You can filter the following 
types of information in your report: 

• Report Style - Only Hierarchical is available at this time

• Static Power values

• Dynamic Power values

• Clock Domain information

• Annotated Pin information
19



Chapter 1: Getting Started with SmartPower
Click the checkbox next to the item to include it in your report results. An 
example of the beginning of a textual power report is shown in Figure 1-10.

Figure 1-10. Sample Textual Report from SmartPower (partial)

The SmartPower report returns a complete list of all the blocks, gates, and nets 
and the related power consumption in the device. It returns the same 
information displayed in the Dynamic tab. The report fully expands all the info 
included in the Dynamic tab by default; use the Block Expansion Control in the 
Preferences dialog box to expand only the blocks you are interested in. 

Importing a VCD File 
The VCD (value change-dump) file is a file format specified in the IEEE 1364 
standard. It is an ASCII file that contains header information, definition of 
variables, and the values of variables. 

You can generate a pre- or post-layout VCD file using ModelSim or any other 
simulation tool that supports VCD file generation. Please refer to the user 
manual of your simulation tool for more information on how to generate a 
VCD file. 
20



Importing a VCD File
Use the following instructions to import a VCD (value change dump) file into 
your design. 

To import a VCD file: 

1. From the File menu in the main Designer window, select 
Import Auxiliary Files. Click Add to browse to your VCD file and 
select it. When you have selected a VCD file, click OK to continue. 

Figure 1-11. Import Auxiliary Files Dialog Box

If you have not yet laid-out the design, the design software guides you 
through place-and-route so that you can import the VCD file. In order to 
successfully annotate your VCD values to the design, Designer must 
complete place-and-route even if you generated your VCD file using 
functional simulation (pre-layout) or timing simulation (post-layout). 

You may import multiple VCD files. If these files conflict (attempt to set a 
different frequency for the same net of your design, for example), the latest 
imported value takes precedence.

2. Specify your VCD import options. Use the VCD Import Options 
window to specify the instance name of your design in the simulation 
21



Chapter 1: Getting Started with SmartPower
testbench (Figure 1-12). The instance name is the instance name of your 
design instantiated in the simulation testbench. Click OK to continue. 

Figure 1-12. VCD Import Options Dialog Box

For example, the instance name of the design “top_comp” in the following 
verilog test-bench is “inst”.

module test;
reg [3:0] DataA, DataB;
wire AGEB;
top_comp inst(DataA, DataB, AGEB);
initial
begin
……………………………
end;

endmodule;

It also possible to identify the instance name of your design in the VCD file. 
You have to look for a line starting with the keyword $scope. For example, 
the instance name of the design “top_comp” in the following VCD file is 
“inst”.

$date
Oct 18, 2001  16:02:16

$end
$version
VERILOG-XL 3.30.p001

$end
$timescale
100ps

$end

$scope module inst $end
……………………………

3. Check the Log window for notification that you successfully 
imported the VCD file (“The Import command succeeded...”). 

Even if the Import command succeeds, Actel recommends that you verify 
which of the pins have been affected after you import the file. 
22



Importing a VCD File
To verify results of an imported VCD file, launch SmartPower and navigate to 
the Activity tab screen to view pins with annotated switching activities (Figure 
1-13). If your file was imported successfully, you will see a long list of pins with 
annotated switching activity and specific individual frequencies. 

Figure 1-13. Successful VCD Import - Annotated Switching Activity Results

Check the annotated values to gauge the effect of your VCD file. For example, 
the “Clock” pin in Figure 1-13 is an input of the design directly controlled by 
the stimuli generator. So it is easy to check the computed frequency and ensure 
that it is correct (close to 50 MHz for this example).

It may be that some pins of your design are not annotated by a VCD import 
command (like DFC1B_15/U0:Q in the example above). This happens if you 
simulate a pre-synthesis netlist; it is normal because not all logic elements are in 
the pre-synthesis netlist. Thus, for accurate power estimation it is better to run 
post-layout simulation with a back-annotated netlist.

Pins w/ Annotated
Switching Activity
23



Chapter 1: Getting Started with SmartPower
Importing a SAIF File 
The SAIF (Switching Activity Interchange Format) is the EDA industry's most 
widely used power format that provides switching activity information to 
power optimization and analysis tools. 

Use the following instructions to import a SAIF file into your design. 

To import a SAIF file: 

1. From the File menu in the main Designer window, select 
Import Auxiliary Files. Click Add to browse to your SAIF file and 
select it. When you have selected a SAIF file, click OK to continue. 

If you have not yet laid-out the design, the design software guides you 
through place-and-route so that you can import the SAIF file. In order to 
successfully annotate your SAIF values to the design, Designer must 
complete place-and-route even if you generated your SAIF file using 
functional simulation (pre-layout) or timing simulation (post-layout). 

It is also possible to import multiple SAIF files. If these files conflict 
(attempt to set a different frequency for the same net of your design, for 
example), the latest imported value takes precedence.

2. Specify your SAIF import options. Use the SAIF Import Options 
window to specify the instance name of your design in the simulation 
24



Importing a SAIF File
testbench (Figure 1-14). The instance name is the instance name of your 
design instantiated in the simulation testbench. Click OK to continue. 

Figure 1-14. SAIF Import Options Dialog Box

You must include the hierarchy in the instance name, as in 
“TEST_BENCH/UUT” in the example above. 

The following example shows how to identify the instance name of your 
design in the SAIF file. For example, the instance name of the design in the 
following SAIF file is “TEST_BENCH/UUT”.

(SAIFILE
(SAIFVERSION "1.1")
(DESIGN 2ff)
(DATE "Fri May 10 14:48:46 2002")
……………………………
(TIMESCALE 1ns)
(DURATION 50000)

(INSTANCE TEST_BENCH/UUT (PORT (OUT_PORT (TC 26) (IG 0) (T1 
25994)
(T0 22000) (TX 2006))))
(INSTANCE TEST_BENCH/UUT/\outpad/U0/U1\ (PORT (Y (TC 26) (IG 0) 
(T1 25995) (T0 22000) (TX 2005))))
(INSTANCE TEST_BENCH/UUT/\ff1/U0\ (PORT (Q (TC 27) (IG 0) (T1 
26000)
(T0 22997) (TX 1003))))
(INSTANCE TEST_BENCH/UUT/\clkpad/U0/U0\ (PORT (Y (TC 99) (IG 0)
(T1 25000) (T0 24999) (TX 1))))
……………………………

3. Check the Log window for notification that you successfully 
imported the SAIF file (“The Import command succeeded...”). 

To verify results of an imported SAIF file, launch SmartPower and navigate to 
the Activity tab screen to view pins with annotated switching activities (Figure 
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1-15). If your file was imported successfully, you will see a list of pins with 
annotated switching activities, like the “U9/U0/U1:Y” pin in Figure 1-15. 

Figure 1-15. Successful SAIF Import - Annotated Switching Activity Results

It may be that some pins of your design are not annotated by a SAIF import 
command (like “U2/U0/U0:PAD” in Figure 1-15). This sometimes happens if 
you simulate a pre-synthesis netlist. It is normal; not all logic elements are in the 
pre-synthesis netlist. Thus it is better to do a post-layout simulation with a 
back-annotated netlist for the most accurate power estimation.

Pins w/ Annotated
Switching Activity
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2
Using SmartPower

This chapter contains information on how to use SmartPower to 
analyze your power consumption. For more information on the 
SmartPower interface, please refer to “Getting Started with SmartPower” on 
page 7. 

SmartPower Calculation
SmartPower calculates two power values for your design:

1. Static Power - This value is family and die-size dependent and is 
estimated at the design level (at this time all die sizes for each family have 
the same static power). 

2. Dynamic Power: This value is a summation of the dynamic power 
consumed by each element of the design (nets, modules, IOs, RAM, 
FIFO, PLL, etc.). 

Note: The examples below are for general evaluation purposes only. They 
are not a precise representation of the actual calculations, since each 
calculation takes into account family-specific information. 

• For a net, 

where C is the total capacitive loading of the net (extracted from 
the routing topology), V is the net's voltage swing, and F is the 
average switching frequency. 

• For a module, the power is computed using a characterized 
library (by family and die-size) describing a specific power model 
for each type of module. For example, the power model of a flip-
flop is given by

 

where FCK is the average clock-input frequency for this flip-flop, FDOUT 
is its average data-output frequency, and PCK, PDOUT, and PDin are three 
constants estimated by electrical simulation and silicon characterization 
for this flip-flop module. 

• For an IO, the formula used for computing the power consumption 

P C V2 F⋅ ⋅=

P PCK F⋅ CK PDOUT F⋅+ DOUT PDin FDin⋅+=
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depends on the IO technology and the family. For example, for a TTL 
output, the dynamic power is given by

where C is the output load of the port (35 pf for TTL), V is the 
output's voltage swing (3.3 V for TTL), PINT represents an internal 
power contribution dissipated in the pad, and F is the average 
switching frequency of the IO. 

• For a complex block, like a RAM, a FIFO, or a PLL, SmartPower uses a 
high-level power model that integrates design parameters. 

SmartPower automatically computes all the constant parameters of 
these equations. However, the frequencies depend on the target 
frequencies of your design. Since it is impractical to enter each 
frequency manually, SmartPower has several flows that help you to 
estimate the frequencies and calculate the power consumption. 

Power Analysis with SmartPower
The procedure for power analysis with SmartPower may be roughly 
divided into four steps: 

1. Define clock domains (Domains tab) - Define clock domains, and specify a 
clock frequency and a data frequency for each clock domain.

2. Specify individual pin frequencies (Activity tab) - This step is optional, but 
gives you pin-by-pin control of the frequency.

3. View global power consumption (Summary tab) - View global power at the 
design level and its impact on junction temperature.

4. Analyze power consumption (Dynamic tab) - View detailed hierarchical 
analysis of your power consumption (this step is also optional). If your 
power consumption exceeds your budget, this step helps you identify where 
there is room for improvement.

Each of these steps is described in detail below. 

P PINT F⋅ C V2 F⋅ ⋅+=
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Define Clock 
Domains

When you run SmartPower, it researches your existing clock domains and 
partitions your design automatically. You may wish to review the list of clock 
domains in the Domains tab to ensure that all the clocks of your design are 
included in the list. Add or remove clocks as necessary.

To add a new clock domain: 

1. Open the Create Clock Domain dialog box. Click the Domains tab, 
and click the Add Domain button. Select Clock Domain from the drop 
down menu.

2. Create a new clock Domain. Select a potential clock pin, specify a 
clock and data frequency, and click Create. The new clock domain appears 
in the Domains window. If you select an existing clock-pin from the drop-
down menu, the lists of clock-pins and data-pins of this new clock domain 
are computed automatically based on the netlist topology. 

You may wish to create an empty clock domain and fill the lists of clock-
pins and data-pins manually. If so, do not select a clock-pin, just type a new 
name for your clock domain.

For more information on the Clock Domain dialog box, please refer to 
“Domains Tab” on page 15. 

Beyond the verification of the list of clock domains, you may also wish to verify 
that the lists of clock-pins and data-pins computed for each clock domain are 
correct.

To verify the lists of clock-pins and data-pins of a clock domain: 

1. Select a Clock Domain. Click the Domains tab, and select a specific 
Domain in the list.

2. Display the list of clock-pins or data-pins of this Domain. A 
drop-down menu in the Domain tab enables you to select clock-pins or 
data-pins. SmartPower displays the list of pins corresponding to your 
selection below the drop-down menu. You can add or remove clock-pins 
and data-pins as necessary.

3. Remove a pin from a clock domain. Highlight the selected pin and 
click the Remove button. The pin is removed from the clock domain, and 
is made available in the list of pins that you can add in another clock 
domain.
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4. Add a pin in a clock domain. Highlight the selected pin in the list of 
pins that are not yet in a domain and click the Add button. This pin is added 
to the clock domain. It is a clock-pin or a data-pin, depending on the 
specification of the drop-down menu when you click the Add button.

Note: You cannot add a pin that exists in another domain until you free it 
from the existing domain. The pin is unavailable until you remove it 
from the existing domain. 

After you have verified that all the clocks of your designs are correctly 
identified and constructed, you must specify the correct clock and data 
frequency for each clock domain. 

To specify a clock and data frequency, highlight the Clock/Data 
frequency cell and type in a new value. SmartPower defaults to 10 
MHz for each clock frequency, and 1MHz for the data frequency. Input 
your target for each clock and data frequency (5% of your clock 
frequency is a typical guideline for your data frequency - this corresponds to a 
toggle-rate of 10%.)

Not all the pins/gates/nets of your design are associated with a specific 
Clock. For example, the frequency of a design input port is not always 
correlated to a clock frequency. By extension, all pins that are 
upstream of the first level of sequential elements are not associated 
with any clock. SmartPower creates an InputSet by default that it uses 
to group all the pins that are controlled by design inputs (instead of 
sequential elements). 

To verify the InputSet: 

1. Select the InputSet. Click the Domains tab, and select the domain 
named InputSet in the list.

2. Verify the list of pins of this Domain. All the input ports of your 
design (except the clocks) belong in the InputSet. Also, all the pins 
that are between these input ports and the first level of sequential 
elements belong in the InputSet. You can add or remove pins as 
necessary.

3. Specify an average input frequency. SmartPower uses the same 
frequency for all pins of the InputSet. The default InputSet 
frequency is 1 MHz. Type in a new value to change it.
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You may wish to split the InputSet into several sets in order to specify 
different frequencies. A classic example is to create a ResetSet, a reset-
tree with a very low frequency.

To split the InputSet into several sets: 

1. Create a new Set of Pins. In the Domains tab, click the New button, 
and select Set-of-Pins from the drop down menu. In the Create Set Of Pins 
dialog-box type a name and a frequency for the new set and click Create. 
The new set of pins appears in the Domains window. You can only create 
an empty set of pins, but it is possible to add pins in this Domain latter.

2. Remove a group of pins from the InputSet. Click the Domains 
tab, and select the domain named InputSet in the list. Highlight the 
pins that you want to remove and click the Remove button.

3. Add this group of pins in the new Set of Pins. Click the Domains 
tab, and select the newly created set of pins in the list. Highlight the 
pins in the list of pins that are not yet in a domain, and click the 
Add button. Repeat these 3 steps as necessary to create multiple 
inputs sets.

Specify 
Individual Pin 
Frequencies

The Clock Domains tab enables you to specify an average clock and 
data frequency for each clock domain, and also an average frequency 
for each set of pins. This gives you an initial estimate of the power 
consumption of your design. However, if this estimate is not accurate 
enough, you may wish to refine it with a pin-by-pin annotation of the 
frequency.

To specify a frequency annotation for an individual pin: 

1. Locate the pin in the Activity tab. You may need to select different 
clock domains from the drop-down menu on the Activity tab, then search 
in the Not-Annotated Pins list to find the specific pin. It is possible to use 
filters to facilitate this research.

2. Specify a new frequency for this pin. Highlight the pin in the list 
of Not Annotated pins, enter a new frequency value, and click the 
Set To button. The pin with this new frequency appears in the list 
of annotated pins. Repeat these 2 steps as necessary to annotate the 
frequency of several pins.
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This annotation procedure enables you to set the frequency of an 
individual pin, but this does not mean that the pin is removed from its 
clock-domain. A frequency annotation just overrides the domain-level 
frequency.

You may need to change or remove a frequency annotation of an 
individual pin. This may be useful when you import a VCD (value 
change-dump) file or a SAIF (Switching Activity Interchange Format) 
file.

To change the frequency annotation of an individual pin: 

1. Locate the pin in the Activity tab. You may need to select different 
clock domains from the drop-down menu on the Activity tab, and then 
search in the Annotated Pins list to find the specific pin. You can use filters 
to facilitate the search.

2. Specify a new frequency for this pin. Highlight the pin in the list 
of Annotated pins, enter a new frequency value, and click the  
Set To button. The pin appears in the list of annotated pins with this 
new frequency. Repeat these 2 steps as necessary to change the 
frequency annotation of several pins.

To remove the frequency annotation of an individual pin: 

1. Locate the pin in the Activity tab. You may need to select different 
clock domains from the drop-down menu on the Activity tab, and then 
search in the Annotated Pins list to find the specific pin. You can use filters 
to facilitate the search.

2. Specify a new frequency for this pin. Highlight the pin in the list of 
Annotated pins and click the Remove button. The pin appears in the list of 
Not Annotated pins. Repeat these 2 steps as necessary to remove the 
frequency annotation of several pins.

Note: You can also import a VCD file. See “Importing a VCD File” on 
page 20 for more information. 
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View Global 
Power 
Consumption 
at the Design 
Level

Click the Summary tab to view global power consumption at the design level. 
The Summary tab shows your designs' estimated Power Consumption, Average 
Switching Activities, and Temperatures. For more information on the Summary 
tab, please refer to “Summary Tab” on page 11. 

The power estimation reported in the Summary tab is the total static and 
dynamic power consumption of your design. For a more detailed view of this 
power consumption, click the Dynamic tab. 

Average Switching Activities are useful when you import a VCD file or SAIF 
file. Since these files enable you to specify the frequency of each pin 
individually, it is often useful to know the average clock-pins frequency and 
data-pins frequency for a particular clock domain. 

To view the Average Switching Activities of a clock domain: 

1. Select a clock domain. Click the Summary tab, and select a specific 
domain in the list.

2. Verify the average clock frequency. If you did not specify a 
frequency annotation for any clock-pin in this clock domain, the average 
value is equal to the default clock-frequency of the clock domain. If you 
annotated one or several clock-pins, SmartPower takes these specific 
annotations into account to compute an average value.

3. Verify the average data frequency. If you did not specify a frequency 
annotation for any data-pin in this clock domain, the average value is equal 
to the default data-frequency of the clock domain. If you annotated one or 
several data-pins, SmartPower takes these specific annotations into account 
to compute an average value.

Junction Temperature

The junction temperature estimation T is dependent on the thermal resistance 
(θJA) (which is itself package and cooling-style dependent), and also on the 
ambient temperature TA and the total dynamic power consumption of your 
design P. The formula is:  where

To estimate the junction temperature: 

1. Verify your package. You cannot change your package directly in 
SmartPower, because it may obsolete your place and route information (and 

TJ TA P θJA⋅+=

θJA f Pkg & Cooling Style( )=
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thus it may severely impact the total power consumption). If you wish to 
choose another package, you have to do it in Designer - Tools - Device 
Selection.

2. Select a cooling-style. Click the Summary tab, and select a cooling-style 
in the list. Thermal resistance changes automatically when you update the 
cooling-style.

3. Specify an ambient temperature. Enter an ambient temperature 
(default value is 25ºC), and click the Set button.

Note: The junction temperature value changes according to the package, 
cooling style, and ambient temperature values you choose. 

Analyze Power 
Consumption 
at the Block, 
Net, or Gate 
Level

The Dynamic tab displays the estimated power consumption of individual 
blocks, gates, and nets and enables you to make a hierarchical analysis of your 
power consumption. The dynamic tab may also help you to improve your 
power consumption by identifying the blocks, gates and nets consuming a 
significant amount of power. 

You can export (to a text file) and print the grid that lists your design’s power 
consumption. To do so, select the elements of the grid that you wish to export 
or print, and then from the File menu select Export Grid or Print Grid, 
respectively. 

To identify the blocks, gates, or nets that are consuming the most 
power: 

1. Expand the design hierarchy. The Dynamic tab enables you to 
expand your design hierarchy and view a complete list of the blocks in your 
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design. Click the '+' next to your design to view the hierarchy. Click the '+' 
next to a sub-block to view its sub-elements (Figure 2-1). 

Figure 2-1. Possible Clock Pin with High Fanout

2. Select a block. By default SmartPower selects the design-level block, but 
you can always select another block in the hierarchical-tree. The report 
window displays the list of sub-elements of the selected block. By default, 
this list includes all sub-elements. SmartPower displays the dynamic power 
consumption of each sub-element with useful information like the fanout 
and the driver-name for a net, or the macro model-name for a gate. 

3. Sort and filter the sub-elements to find the block, gate, or net 
that is using the most power. By default SmartPower sorts the sub-
elements according to their power consumption. The top of the list of sub-
elements gives you the main sources of dynamic power consumption at the 
hierarchical level. Double-click a column heading to sort by that column (or 
to change the sort order). Click a checkbox to limit the list of sub-elements 
to a list of gates, nets or blocks. 

Block Level
Hierarchy

Blocks, Nets
and Gates
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SmartPower Results
Use the information below to manage the way SmartPower returns your results. 

Generating a 
Power Report

The power report enables you to quickly determine if any power consumption 
problems exist in your design. The power report lists the following 
information:

• Global device information, and SmartPower Preferences selection 
information (see “SmartPower Preferences Dialog Box” on page 17 for more 
information on the Preferences)

• Design level static power summary

• Dynamic power summary

• Hierarchical detailed power report (including gates, blocks, and nets), with a 
block by block, gate by gate, and net by net power summary

To generate a power report:

1. In the Tools menu, click Report Power. The Power Report dialog 
box appears (Figure 2-2). You have the following options: 

Figure 2-2. Power Report Dialog Box

• Static Power - Returns static power information

• Dynamic Power - Returns dynamic power information

• Report Style - Specifies report style (only hierarchical available at this 
time)
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2. For additional Power Report Options, click the Options 
button. This displays the Preferences dialog box, as shown in Figure 2-3. 

Figure 2-3. Preferences Dialog Box

3. Select analysis preferences. The default settings are shown in Figure 
2-3. You have the following options for your Power Report:

• Units - Sets units preferences for power and frequency

• Operating Conditions - sets preferences for operating 
conditions (Typical is the only option available at this time)

• Block Expansion Control - Filters reported power values 
returned in the report. This box does not control which values are 
included, rather it specifies which blocks are detailed/expanded.

You may specify which blocks are expanded using a minimum 
power value, a minimum power ratio (with regards to the total 
power of the design) and a maximum hierarchical depth; a 
filtered value is not included in displayed lists, but still counted 
for upper hierarchical levels. 

4. Once you are satisfied with your selections, click OK in the 
Preferences dialog box and then click OK in the Power 
Report dialog box. SmartPower displays the report in a separate 
window. 
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Product Support

Actel backs its products with various support services including Customer 
Service, a Customer Technical Support Center, a web site, an FTP site, 
electronic mail, and worldwide sales offices. This appendix contains 
information about contacting Actel and using these support services.

Actel U.S. Toll-Free Line
Use the Actel toll-free line to contact Actel for sales information, technical 
support, requests for literature, Customer Service, investor information, and 
using the Action Facts service.

The Actel toll-free line is (888) 99-ACTEL.

Customer Service
Contact Customer Service for non-technical product support, such as product 
pricing, product upgrades, update information, order status, and authorization.

From Northeast and North Central U.S.A., call (408) 522-4480. 
From Southeast and Southwest U.S.A., call (408) 522-4480. 
From South Central U.S.A., call (408) 522-4434. 
From Northwest U.S.A., call (408) 522-4434. 
From Canada, call (408) 522-4480. 
From Europe, call (408) 522-4252 or +44 (0) 1276 401500. 
From Japan, call (408) 522-4743. 
From the rest of the world, call (408) 522-4743. 
Fax, from anywhere in the world (408) 522-8044.

Actel Customer Technical Support Center
Actel staffs its Customer Technical Support Center with highly skilled engineers 
who can help answer your hardware, software, and design questions. The 
Customer Technical Support Center spends a great deal of time creating 
application notes and answers to FAQs. So, before you contact us, please visit 
our online resources. It is very likely we have already answered your questions.
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Guru Automated Technical Support
Guru is a web-based automated technical support system accessible through 
the Actel home page (http://www.actel.com/guru/). Guru provides answers to 
technical questions about Actel products. Many answers include diagrams, 
illustrations, and links to other resources on the Actel web site. 

Web Site
Actel has a World Wide Web home page where you can browse a variety of 
technical and non-technical information. The URL is http://www.actel.com. 

Contacting the Customer Technical Support Center
Highly skilled engineers staff the Technical Support Center from 7:00 A.M. to 
6:00 P.M., Pacific Time, Monday through Friday. Several ways of contacting the 
Center follow:

Electronic Mail You can communicate your technical questions to our e-mail address and 
receive answers back by e-mail, fax, or phone. Also, if you have design 
problems, you can e-mail your design files to receive assistance. We constantly 
monitor the e-mail account throughout the day. When sending your request to 
us, please be sure to include your full name, company name, and your contact 
information for efficient processing of your request.

The technical support e-mail address is tech@actel.com.
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Contacting the Customer Technical Support Center
Telephone Our Technical Support Center answers all calls. The center retrieves 
information, such as your name, company name, phone number and your 
question, and then issues a case number. The Center then forwards the 
information to a queue where the first available application engineer receives 
the data and returns your call. The phone hours are from 7:00 A.M. to 6:00 P.M., 
Pacific Time, Monday through Friday. The Technical Support numbers are:

(408) 522-4460
(800) 262-1060

Customers needing assistance outside the US time zones can either contact 
technical support via email (tech@actel.com) or contact a local sales office. 
Please see our list of Worldwide Sales Offices.
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Worldwide Sales Offices

Headquarters
Actel Corporation 
955 East Arques Avenue 
Sunnyvale, California 94086 
Toll Free: 888.99.ACTEL
Tel: 408.739.1010 
Fax: 408.739.1540

US Sales  
Offices

California

Bay Area
Tel: 408.328.2200
Fax: 408.328.2358

Irvine
Tel: 949.727.0470
Fax: 949.727.0476

Newbury Park
Tel: 805.375.5769
Fax: 805.375.5749

Colorado

Tel: 303.420.4335
Fax: 303.420.4336

Florida

Tel: 407.977.6846
Fax: 407.977.6847

Georgia

Tel: 770.277.4980 
Fax: 770.277.5896

Illinois

Tel: 847.259.1501
Fax: 847.259.1575

Massachusetts

Tel: 978.244.3800
Fax: 978.244.3820

Minnesota

Tel: 651.917.9116
Fax: 651.917.9114

New Jersey

Tel: 609.517.0304

North Carolina

Tel: 919.654.4529
Fax: 919.674.0055

Pennsylvania

Tel: 215.830.1458
Fax: 215.706.0680

Texas

Tel: 972.235.8944
Fax: 972.235.9659

International Sales 
Offices

Canada 
235 Stafford Rd. West, Suite 
106 
Nepean, Ontario K2H9C1, 
Canada
Tel: 613.726.7575 
Fax: 613.726.8666

France 
361 Avenue General de Gaulle 
92147 Clamart Cedex
Tel: +33 (0)1.40.83.11.00 
Fax: +33 (0)1.40.94.11.04

Germany 
Lohweg 27, 
D-85375 Neufahrn 
Germany
Tel: +49.(0)81.659.584.0 
Fax: +49.(0)81.659.584.10

Italy 
Via dei Garibaldini 5  
20019 Settimo Milanese 
Milano, Italy 
Tel: +39 (0)2.3809.3259 
Fax: +39 (0)2.3809.3260

Japan 
EXOS Ebisu Building 4F 
1-24-14 Ebisu Shibuya-ku 
Tokyo 150
Tel: +81 (0)3.3445.7671 
Fax: +81 (0)3.3445.7668
Korea
30th floor, ASEM Tower, 
159-1 Samsung-dong,  
Kangnam-ku, Seoul, Korea 
Tel: +82 (0)2.6001.3382 
Fax: +82 (0)2.6001.3030

United Kingdom 
Maxfli Court 
Riverside Way 
Camberley, Surrey 
GU15 3YL 
United Kingdom
Tel: +44 (0)1276.401450 
Fax: +44 (0)1276.401490
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	3. Check the Log window for notification that you successfully imported the SAIF file (“The Import command succeeded...”).

	Figure 1-15. Successful SAIF Import - Annotated Switching Activity Results
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